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Learning Objectives
•
•
•
•

discover the new automated PDF publishing capabilities in Vault 2018
learn how to set up the publishing of 2D PDFs during the release process
explore the different options for publishing PDFs of AutoCAD and Inventor
drawings
learn how to control access rights, property mapping, naming, and revisioning of
the published PDFs

Description
In the latest release, Vault data management software introduced the capability to automatically
publish and share 2D PDFs of drawings during the release process. In this class, we’ll explore
the different aspects of this new functionality. We’ll take you through the steps to correctly set
up this publishing process in Vault and show you the different publish options. The PDF format
of a 2D design file is used in many firms to facilitate communications among engineering,
purchasing, manufacturing, and other departments. We’ll also teach you how to let users
outside your engineering department access the PDFs for printing and other workflows. This
session will feature Vault Professional data management software and Vault Workgroup,
including the use of the Vault Job Processor.

Speaker(s)
Peter Van Avondt
Technical Specialist - Data Management
Autodesk BV
Peter Van Avondt works for Autodesk as a Technical Specialist Data Management (PDM/PLM)
in Northern Europe, based in Belgium. After graduating as a master in electromechanical
engineering he joined an Autodesk channel partner as a technical consultant specialized in 3D
CAD and product data management (PDM). For the last 15 years he has built up a lot of
experience in variety of Autodesk design tools as well as with Autodesk Vault and Fusion
Lifecycle. In his current role, he uses this wealthy knowledge helping Autodesk resellers,
prospects, and customers to adopt and implement the Autodesk solutions across different
industries including industrial machinery, pharmaceutical, architecture, engineering and
construction companies.
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New Automated PDF Creation for Document Control
Vault 2018 introduces the #1 requested feature, the ability to create PDF files during the
release process. Many firms use the PDF format of a 2D Drawing file to facilitate internal
communications among engineering, purchasing, manufacturing and other departments.
Further, PDF files are the de facto standard for external communication of new designs with
customers as well as suppliers.
Autodesk Vault 2018 automatically renders PDF formats from 2D design files using the
same settings as the authoring CAD systems. It supports all Inventor and AutoCAD
drawings files and allows administrators of Vault to produce the same PDF quality as their
CAD administrator counterparts.
Administrators may configure Vault 2018 to set how all PDFs are created by setting the
PDF Options in Vault. The PDF files can be attached to the parent drawing, uploaded to the
same or different file location in Vault and synchronized with the revision of the parent file.
Specific settings for AutoCAD and Inventor drawings ensure the quality of the published
PDF.
The Publish PDF capability within Vault 2018 supports engineering’s team to keep all teams
like shop-floor up-to-date while continue to maintain secure data so the right people can
access the right data at the right time through the Vault Thin Client for example.
The Administrator has also the flexibility to configure which properties to be inherited from
the CAD files and assigned to the PDFs. The PDFs are automatically assigned to a specific
category, lifecycle definition which allow the administrators to manage their security access
and properties independent of the associated design files.
In this document, you will get an overview on how to setup and configure the 2D PDF
Publishing Feature within Autodesk Vault 2018.
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Out of the box Vault setup
When a new Vault gets created in Vault Workgroup or Professional 2018 a new Category,
Category Rule, Lifecycle, and a Lifecycle Action are available.
Note: For existing Vaults that have been migrated to Vault 2018, the Category, Category
Rule and Lifecycle need to be manually configured. This will be explained later in this
document.
Let’s take a deep dive into these new out of the box settings...

The PDF Category
All PDF files created for document control in Vault 2018 are automatically assigned
to the Design Representation category. A dedicated category allows administrators
to manage their rules, lifecycles, and properties independent of the associated
design files.
As a result, e.g. non-engineering staff like shop-floor users can access released
PDFs within the Vault Thin Client w/o necessary need to have access to the native
CAD files for printing and other follow workflows.
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The Category Assignment Rule
A Design Representation Assignment Rule is used to assign the Design Representation
category. Design Representation is also a special classification set on the PDF files
created by the Job Processor, so Vault's logic identifies them.

This classification can be assigned, through the API, for other files by developing custom
solutions. All files with the File Classification of Design Representation can be attached
to a CAD file w/o creating a new CAD file iteration.
Note: More information about the specific API function can be found in the Vault SDK:
Autodesk.Connectivity.WebServices Namespace > DocumentService Class : AddDesignRepresentationFileAttachment
Adds an attachment to a Design Representation file without increasing the version of the file
Parameters
fileId The ID of the parent file.
attachment The attachment.
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The PDF lifecycle definition
A Design Representation Process lifecycle exists with three states; Released, Work in
Progress and Obsolete. When the PDF file gets created after the design file is released,
it uses the Design Representation Process lifecycle through the assignment of the
Design Representation Category.

The administrator needs to configure the security of the Released state so that future
versions of the PDF can be created. This means that the Job Processer user will need to
have at least read and modify rights on the PDF file in the release state:
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Configure a migrated Vault for PDF Publishing
Existing Vaults that have been migrated to Vault 2018 will not be automatically configured to
have the specific PDF settings. The PDF Category, Category Rule and Lifecycle need to be
manually configured.
You can follow these steps to configure your Vault:
1. Create the Design Representation Category:
a. Go to “Tools” menu
b. Select “Administration”
c. Go to the “Behaviors” tab
d. Select “Category”
e. Within the Category types dropdown select “File Categories”
f. Select “New”
g. Configure the category as follows:

h. Click “OK” and close the “Configure Categories” dialog box
Note: You are not bound to the Category Name “Design Representation”, however this
name will be used throughout the rest of this documentation.
2. Create the category assignment rule:
a. Within the “Behaviors” tab in the Vault settings dialog box, Select “Rules”
b. Select “File Rules” from the filter dropdown
c. Select “New”
d. Create the rule as follows:

Note: You are not bound to the Rule Name “Design Representation”, however
this name will be used throughout the rest of this documentation.
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e. Click OK to confirm
f. Within the Rule Condition Builder, create the following rule:
- Property: “Classification”
- Condition: “is”
- Value: “Design Representation”
g. Click on “Add” to add the rule to the “Rule Criteria”

h. Click on OK to confirm and close the assignment rules
Note: Make sure to place the assignment rule in the correct order. If you have already
an assignment rule for PDF documents in place you need to put the Design
Representation rule before this rule:
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3. Create the Design Representation Process Lifecycle
a. Create a new lifecycle definition with the following settings
- Definition Name: “Design Representation Process”
- Category: “Design Representation”
- Description is optional
Note: You are not bound to the Lifecycle Definition Name “Design Representation
Process”, however this name will be used throughout the rest of this documentation.
b. Add following lifecycle states:
- Released
- Work in Progress (optional)
- Obsolete (optional)
c. Make the Released state default
d. Configure for all these states the Security.
Make sure that in the release state the Job Processor user has at least read and
modify rights.

e. All other Lifecycle state configuration settings are optional.

Note: For more information about how to setup a lifecycle definition please refer to:
https://knowledge.autodesk.com/support/vault-products/learnexplore/caas/CloudHelp/cloudhelp/2018/ENU/Vault-Admin/files/GUID-088F0236-B5B74E35-B218-BD2D253B87F6-htm.html
Note: Besides a specific Lifecycle, Revision schemes and Properties can be assigned to
the Design Representation Category. This will be explained in the advanced
configuration section of this document.
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Publish 2D PDF during Engineering Release Process
Once the PDF configuration is in place (either the out of the box configuration or the manual
configured one) administrators may configure Vault 2018 to automatically publish PDF files
for document control during final release. During this transition, Vault's Job Processor
automatically updates the drawing references and properties to ensure an accurate PDF
representation.

Job Processor Setup
To start creating 2D PDF files, an Administrator must turn on the Job Server and
configure the system to start using the capability.

With Vault 2018 Job Processor will have 2 new jobs available out of the box:
- autodesk.vault.pdf.create.idw
- autodesk.vault.pdf.create.dwg

Note: For publishing pdf files from Autocad 2D Drawings the Job Processor uses
DWG Trueview. For Inventor 2D drawings Autodesk Inventor is currently used
during the publishing process.
Note: More information about setting up a Job Processor can be found here:
https://knowledge.autodesk.com/support/vault-products/learnexplore/caas/CloudHelp/cloudhelp/2018/ENU/Vault-Admin/files/GUID41C25A0B-81DC-4E5B-B98B-3EA7B280CD97-htm.html
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Configure your Engineering Lifecycle
To automatically publish 2D PDF files during your engineering lifecycle, an
Administrator must add specific actions to the lifecycle state transitions. In Vault
2018 2 new transition actions are added to the actions list:
- Synchronize properties and update pdf using Job Server
- Synchronize properties, update view and update pdf using Job Server

Note: These actions are only valid for File Lifecycle Definitions
The following steps explains how to configure your engineering release lifecycle
to automatically publish 2D PDFs:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.

Go to “Tools” menu
Select “Administration”
Select “Vault Settings”
Select the “Behaviors” Tab
Select “Lifecycles…” under Lifecycles and Revisions
Select your engineering release lifecycle (e.g. “Flexible Release
Process”)
Select the “Edit” button
Initiates “Lifecycle Definition – Flexible Release Process” dialog
Select the “Transitions” Tab
Select a lifecycle transition (i.e. “Work in Progress” to “Released”
transition)
Click on the “Edit” button
Select the “Actions” Tab
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13.

Select “Synchronize properties and update pdf using Job Server” or
“Synchronize properties, update view and pdf using Job Server” from the
dropdown list.

Note: Make sure you are also ticking the checkbox for this action.
14.
15.
16.

Click on the OK button to confirm your settings
Close the Life Cycle Definition Dialog
Close the Vault settings Dialog

Important note: However you could configure the publish PDF action on any
given lifecycle transition, the published PDF job will only be executed when the
source file is transitioned to a released state.

Once you have done the configuration of your engineering lifecycle definition you can start
publishing your 2D PDF files. Depending on the PDF publishing options chosen, other settings
need to be made to the engineering release lifecycle definition or the Design Representation
Category. Please refer to the specific PDF Publishing options in the next section of this
document for more details.
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Create PDF Files for legacy Released Data
The Job Processor Job to create and attach PDF Design Representation drawings for
Inventor 2D and AutoCAD 2D drawings is always initiated from a lifecycle transition to a
released state. For existing, released drawings you can’t create the PDF files without a
re-release workflow.
To overcome this a Vault Data Standard Extension can be installed that implements a
manual command to initiate the job execution for legacy drawings without version /
revision increment:

Just select the Released Files (multi select supported) and select the Update PDF View
Command from the actions menu. For every individual drawing the PDF Publishing Job
will be added to the Job Queue.
The Vault Data Standard Extension can be downloaded from the Autodesk Knowledge
network: https://knowledge.autodesk.com/community/article/115436
Follow the step by step instructions included in the download - subfolder
\Documentation\ - to integrate the feature in your environment.
Note: To use this extension, Vault Data Standard Version 2018.x should be installed.
More information about Vault Data Standard can be found here:
https://knowledge.autodesk.com/support/vault-products/learnexplore/caas/CloudHelp/cloudhelp/2018/ENU/Vault-General/files/GUID-D475D22B3873-4B78-9936-DD773F109136-htm.html
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PDF Publishing Options
With all lifecycle, category and other configurations done, it is time to look at the PDF publishing
options. The PDF Options determine how the content is published in the PDF file. You can also
set specific behaviors like whether to attach PDFs to their source files, where to save the PDFs
and if they should take the source revision number, etc.
The PDF Publishing options are found on the Files tab of the Vault Settings dialog box:
(Go to: Tools > Administration > Vault Settings > Files tab)

Within this dialog box the PDF Publishing Options for 2D AutoCAD and 2D files can be
configured separately. However, some of the options are common for both applications: Add as
an Attachment, Upload to Source File Location, Upload To Selected Vault Path and Sync
Revision as Source.
Within the next paragraphs we will explain each of this settings in depth and explore the
Inventor and AutoCAD application settings:

Add as attachment
Using this option, the published PDF file will be linked as an attachment to the source file:

Note: Moving a Design representation file while attached to the source file is allowed,
but will not move the source file (or vice versa). When a published PDF is moved or
renamed the next time a PDF file is published from the source file a new PDF file will be
created with the configured name instead of creating a new file iteration of the renamed
or moved PDF.
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Note: When using Copy design on the source file, the design representation files will be
listed as a linked attachment. Manual remove the PDF from the copy action to avoid
non-matching PDF representation files to be attached to the copied source file:

Note: The pdf can only get attached to the source file if the user logged in on the job
processor (running the pdf publishing job) has modify rights on the source file in the giving
lifecycle state:

JOBSERVER USER HAS MODIFY RIGHTS ON THE RELEASED STATE

Follow
1.
2.
3.
4.
5.
6.
7.
8.

9.
10.

the following steps to setup the correct security settings for the Job Processor User:
Go to “Tools” menu in the Vault Thick Client (logged in as an Adminstrator)
Select “Administration”
Select “Vault Settings”
Select the “Behaviors” Tab
Select “Lifecycles…” under Lifecycles and Revisions
Select your engineering release lifecycle (e.g. “Flexible Release Process”)
Select the “Edit” button
Choose the lifecycle state “Released” to perform the steps below;
a. Select “Security” Tab
b. Add your Job Processor user (if not already present)
c. Modify the Job Processor User’s rights under the “Modify” column
d. Select “Allow”
Select “OK” button once you are done
Close the Lifecycle definition and Vault Settings window
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PDF File Location
By default, the PDF file is placed on the same folder location of the source file.
By unticking the option “Upload to Source File Location” you will have the possibility to
specify a publish folder for your PDF files. The option “Upload To Selected Vault Path”
will then be available and allows you to define specific location within Vault to store the
published PDF file using a Browse dialog:

Note: If you choose to publish the PDFs to a selected Vault Path, the PDFs will be
published in a flat folder structure.

Revision Synchronisation
“Sync Revision From Source” allows both the published PDF and its Source file to have
an identical revision index value.
If you want your PDFs to take the source file’s revision index then your PDF Design
Representation Category must have the same revision scheme as the source files set to
the default:

Follow these steps to configure your Design Representation Category correctly:
1. Go to the “Tools” menu
2. Select “Administration”
3. Go to the “Behaviors” tab
4. Select “Category”
5. Within the Category types dropdown select “File Categories”
6. Select the Design Representation Category
7. Go to the “Revisions” Tab in the “Behaviors” section
8. Click the “Assign…” button
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9. Drag the Default Revision Scheme from the source file category to the Assigned
Revision Schemes:

10. Select the Revision scheme and click on the “Default” button
11. Click OK to apply the changes
12. Close the Categories Configuration and Vault Settings dialog boxes
13. Configuration completed
Note: If your PDF revision scheme is different, or <none>, then PDFs will generate but
without the revision index synced. Because of this mismatch the PDF will not be
attached to the source file even if this publish option was selected.
Note: Only the revision index is synced, the lifecycle states are not synced.

PDF Options for Inventor Drawings
Within the PDF Options dialog box you can configure specific options for Autodesk
Inventor Drawings by selection the “2D Inventor” filter in the Application drop down.
The settings available in Vault are the same settings as within the PDF Publish options
in Inventor:
- Vector Resolution: Set as 400 DPI by default for managing large PDF file
size and appropriate details.
- Plot Object Lineweights: Enables the published PDF file to display a
consistent lineweight for object and consistent lineweight for linetypes.
- All Sheets: Prints all the sheets in the drawing. Will not print sheets for which
the Exclude from Printing option is checked in the Edit Sheet dialog box in the
AutodeskInventor drawing environment.
- All Colors As Black: Prints the drawing in black and white. Embedded
images and shaded views are still printed in color.
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PDF OPTIONS WITHIN AUTODESK INVENTOR

PDF OPTIONS WITHIN AUTODESK VAULT

PDF Options for AutoCAD Drawings
To specify the PDF publishing options for Autocad 2D drawings select “2D
AutoCAD” from the Application Drop down list. Following AutoCAD specific
settings are available:
- Use Page Settings From User DWG: Eliminates the need to reconfigure
page settings in Vault if previously done in the native application. Checked
and cannot be unchecked (always applied).
- Include Model Space: Enables the published PDF file to contain model
space view.
- Include Layouts: Enables the published PDF file to contain model space
view only.
- Initialize Layouts: Supports legacy AutoCAD files.
- Include Font Handling: Enables publishing a PDF file with font styles. This
option is identical to AutoCAD “Capture fonts used in the drawing” setting.
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PDF OPTIONS WITHIN AUTOCAD

AUTOCAD PDF OPTIONS WITHIN AUTODESK VAULT

Note: Compared to the publish options in AutoCAD some limitations do apply:
- Custom Page Setup: The latest Page Setup configured in the Source file will
be used during the PDF Publishing. Currently a page setup override is not
possible. (e.g. print in monochrome)
- Quality control: The default Quality Control settings are used (Vector quality,
Raster image quality, Merge control).
- Layer Publish: Layer information is not included in the published PDF
- Hyperlinks: Hyperlinks are not included in the published PDF
- Bookmarks: Bookmarks are for sheets only
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Advanced PDF Publishing settings
In the previous section an overview of the common PDF publishing options was given. The
following section will cover the more advanced (sometimes hidden) behaviors, capabilities and
options of the PDF publishing feature.

Property synchronisation
To make it possible for non-engineering staff to search and filter on the Published PDF
files without having access to the native source files, the properties from the source files
can be automatically synced to the design representation PDF file.
Note: PDF Content can also be indexed for searching. To find out more please review
the following AKN article: https://knowledge.autodesk.com/support/vault-products/learnexplore/caas/simplecontent/content/indexing-properties-adobe-pdf-files-vault.html
The Administrator has the flexibility to configure which properties to be inherited from the
CAD files and assigned to the PDFs. To configure this, the administrator should assign
the same user defined properties (UDP) from the source file to the Design
Representation Category:
1. Go to the “Tools” menu
2. Select “Administration”
3. Go to the “Behaviors” tab
4. Select “Category”
5. Within the Category types dropdown select “File Categories”
6. Select the “Design Representation” Category
7. Go to the “Properties” Tab in the “Behaviors” section
8. Click the “Assign…” button
9. Drag the Property Definitions from the source file category to the Assigned
Property Definition for the Design Representation Category:

10. Click OK to apply the changes
11. Close the Categories Configuration and Vault Settings dialog boxes
12. Configuration completed
Note: System properties cannot be inherited.
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During the PDF Publishing process, the source file properties are not written back to the
PDF file properties, but only updated on the Vault user defined properties. Therefor it is
important to review your property mappings for the property definitions you want to
assign to the Design Representation Category. Failing of setting the correct mappings
will end in empty properties:

In the above example, you will see that the “Comments” Property is empty for the
Published PDF file however the “Comments” field was filled in the source file. This is due
to the default property mapping on the “Comments” Property definition:

To make sure the property is filled correctly, you need to remove the mapping for the
Provider “Other Files”:
1. Go to the “Tools” menu
2. Select “Administration”
3. Go to the “Behaviors” tab
4. Under “Properties” select the “Properties…” button
5. Navigate to the “Comments” Property (or other property that needs to be
modified)
6. Click the “Edit” button at the top of the dialog box
7. Select the “Mapping” tab
8. From the mappings select the mapping for the “Other Files” provider
9. Click the icon with the black cross to remove it.
10. Click OK to confirm your setting
11. Optional: Repeat for other properties if needed
12. Close the Properties and Vault Settings dialog boxes
13. Configuration completed
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Note: The Provider “Other Files” is also used for other file formats then PDF files. If you
want to capture the property values of these files in a property in Vault I would suggest
you make a specific User Defined Property for these. (e.g. “Comments (Other Files)”)
with a single mapping from the file to that UDP.

Note: Exceptions to this behavior are the following properties: Author, Title, Keywords,
Subject. These are standard PDF file properties that will be filled with the values of the
source file properties during the PDF creation by default. For these properties, you could
keep the default mapping in Vault.

PDF File Naming configuration
When a PDF file gets created, the name of the file is by default the same name as the
parent file plus the “.pdf” extension:

As an Administrator, you will have the ability to customize the file names of PDFs
created by the Job Processor during a transition to the Released lifecycle state.
The configuration needs to be made on each Job Processor that is used for PDF
publishing:
1. Navigate to the JobProcessor.exe.config located in the <install dir>\Vault
Professional 2018\Explorer folder
2. Before making modifications to it, make a backup copy of that file
3. Use a text editing software, such as Notepad, to open and edit the file
Note: Other applications may corrupt the XML file so be careful about the
application that you use.
4. In the appSettings section after the “<add key="TrueViewDwfPublishCount"
value="500"/>” line, you will add the following keys to customize the PDF
name:
<add key="DesignRepresentation.Naming" value="\.(idw)$/PreFix&lt;_name_&gt;-PostFix&lt;_ext_&gt;"/>

Page 23

5. Adjust the “value” to your needs with the following building blocks:
\.(idw)$/PreFix-&lt;_name_&gt;-PostFix&lt;_ext_&gt;

o

\.(idw)$

o
o
o

/
PreFix&lt;_name_&gt;

o
o

-PostFix
&lt;_ext_&gt;

Extension for which this rule applies (mandatory)
Accepted values:
o \.(idw)$
o \.(dwg)$
o \.(idw|dwg)$ Rule applies to IDW and DWG
Separator
Prefix string value: Sets a fixed text as prefix
Filename of the source file without extension
(mandatory field)
Postfix string value: Sets a fixed text as prefix
Source File Extension

6. Save the config file
7. Restart the Job Processor
Example configurations: (note: these should be added as 1 line of text in the config file)
1. Remove Source File Extension: suspension.idw.pdf:
<add key="DesignRepresentation.Naming" value="\.(idw)$/&lt;_name_&gt;"/>

2. Add a Prefix: PreFix-suspension.dwg.pdf:
<add key="DesignRepresentation.Naming" value="\.(dwg)$/PreFix&lt;_name_&gt;&lt;_ext_&gt;"/>

3. Add a PostFix and Remove Extension: suspension-PostFix.dwg.pdf
<add key="DesignRepresentation.Naming" value="\.(dwg)$/&lt;_name_&gt;-PostFix"/>

4. Add a Pre- and PostFix: PreFix-suspension-PostFix.idw.pdf:
<add key="DesignRepresentation.Naming" value="\.(idw)$/PreFix-&lt;_name_&gt;PostFix&lt;_ext_&gt;"/>

Note: If you want to combine rules for AutoCAD drawings and Inventor drawings you
need to use following code:
1. The rule is the same for both AutoCAD and Inventor drawings:
<add key="DesignRepresentation.Naming" value="\.(idw|dwg)$/&lt;_name_&gt;"/>

2. The rule is different for AutoCAD and Inventor drawings:
<add key="DesignRepresentation.Naming" value="\.(dwg)$/PreFix-&lt;_name_&gt;PostFix/\.(idw)$/PreFix-&lt;_name_&gt;-PostFix&lt;_ext_&gt;"/>

This one will result in:
PreFix-suspension-PostFix.dwg.pdf (without extension)
PreFix-suspension-PostFix.idw.pdf (with extension)
Note: If you make an error in configuring the Naming setting, you can end up with either
an error in the Job Queue or with the default naming of your pdf (e.g. drawing1.dwg.pdf)
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Configuring Thin Client Access
The Publish PDF capability within Vault 2018 supports engineering’s team to keep nonengineering staff like shop-floor users always up-to-date. They will be able to access and
search on released design representation in form of PDFs within the Vault Thin Client
w/o necessary a need to have access to the native CAD files for printing and other follow
workflows.

To give shop-floor users as well as other users only access to the PDF files instead of to
the native CAD drawings you will need to add extra security to your files and folders.
This can be done by modifying the lifecycle definitions:
1. Set the security for the “Flexible Release Process”
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2. Set the security for the “Design Representation Process”

Note: look into the Lifecycle Administration section on AKN to setup the security on
lifecycle states: https://knowledge.autodesk.com/support/vault-products/learnexplore/caas/CloudHelp/cloudhelp/2018/ENU/Vault-Admin/files/GUID-088F0236-B5B74E35-B218-BD2D253B87F6-htm.html
Another possible configuration could be to have your PDF files published in 1 Vault
Folder. The security on this folder should be set in a way that non-engineering staff has
only access to that specific folder in Vault:
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Security for the other folders needs to exclude the non-engineering staff (e.g. Sales)
from accessing that location:

Note: To learn more about setting up security refer to the following AKN article:
https://knowledge.autodesk.com/support/vault-products/learnexplore/caas/CloudHelp/cloudhelp/2018/ENU/Vault-Admin/files/GUID-07AB6615-AFDD4C86-96DE-A3D334AF454B-htm.html
Configure your Publish location for the PDF Publishing accordingly:
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-

Using Vault Data Standard:
https://knowledge.autodesk.com/support/vault-products/learnexplore/caas/CloudHelp/cloudhelp/2018/ENU/Vault-General/files/GUID-D475D22B-38734B78-9936-DD773F109136-htm.html

-

Vault 2018 - PDF Design Representation - Submit Job on Legacy Files:
https://knowledge.autodesk.com/community/article/115436

-

Configure Security for Files, Folders, and Custom Objects:
https://knowledge.autodesk.com/support/vault-products/learnexplore/caas/CloudHelp/cloudhelp/2018/ENU/Vault-Admin/files/GUID-07AB6615-AFDD4C86-96DE-A3D334AF454B-htm.html

-

Autodesk Vault Thin Client:
https://knowledge.autodesk.com/support/vault-products/learnexplore/caas/CloudHelp/cloudhelp/2018/ENU/Vault-General/files/GUID-A394FD9E-88EB4592-B6F9-B41D31C14F7D-htm.html
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